
User’s Guide
ADS1x15V2EVM-PDK User's Guide

ABSTRACT

The ADS1x15V2EVM-PDK is comprised of the ADS1x15 evaluation module (EVM) and the PAMBoard
motherboard. The combination of the ADS1x15EVM and PAMBoard allows users to evaluate the functionality
of the Texas Instruments' 16-bit ADS1115 or the 12-bit ADS1015. ADS1x15 refers to what is common to
both devices and EVMs. Any differences in operation between the devices or EVMs is listed separately. The
ADS1x15 devices are ultra-small, low-power, analog-to-digital converters (ADCs) with an integrated comparator.
Each ADS1x15 device has inputs that can be configured as four single-ended or two differential inputs. This
document describes both the EVM hardware platform and the graphical user interface (GUI) software used to
configure and operate the device. The user’s guide also includes the EVM schematic diagram, board layout, and
bill of materials. The EVM platform eases the evaluation of the ADS1x15 device with hardware, software, and
computer connectivity through the universal serial bus (USB) interface.
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1 Introduction
The ADS1x15V2EVM-PDK is a fully assembled evaluation platform designed to highlight the ADS1x15 features
and modes of operation that make this device suitable for low-power applications. The ADS1x15EVM sits on
top of an accompanying precision ADC motherboard (PAMBoard) used as a USB-to-PC GUI communication
bridge. The board combination also serves as an example implementation of connecting a microcontroller (MCU)
to communicate with the ADS1x15 device through an inter-integrated circuit (I2C) interface. Figure 1-1 shows a
block diagram of the ADS1x15V2EVM-PDK.

Note

The ADS1x15EVM requires an external controller to evaluate the ADS1x15 device.

The PAMBoard is controlled by commands received from the ADS1x15V2EVM-PDK GUI, and returns data to
the GUI for display and analysis. If the PAMBoard is not used, the EVM plug-in module format allows for an
alternative external host to communicate with the ADS1x15 by connection through the pin headers J1 through
J4. Connections to the header are identified on the PCB silkscreen and listed in Table 3-1.

The combined ADS1x15EVM and PAMBoard make up the ADS1x15V2EVM-PDK and incorporates the following
features:

• ADS1x15, four input-channel ADC with header or screw terminal block input connections
• Voltage selection of 3.3-V or 5-V operation for the ADS1x15 with level-shifting to the 3.3-V MCU
• Full-scale ranges from 256 mV to 6.144 V
• I2C for communication and configuration

Analog header and 

terminal block

Analog inputs + RC 

filters
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I2C/GPIO Level 

shifter

VDD 3.3 V

PAMBoard

digital

interface

EEPROM

device ID

3.3 V

Analog power

source

3.3 V

5 V

PAMBoard

power

VDD

I2C

Figure 1-1. ADS1x15V2EVM-PDK Functional Block Diagram
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2 Quick Start
The quick start shows a minimalist startup process to get the GUI working with the EVM and to see a simple
example for data collection. Details on each step are described in this document. Specifics regarding the GUI
installation steps are found in Section 4.2.

2.1 Step 1 - Hardware Setup
The EVM hardware configuration consists of verifying the supply settings and adding a source voltage to be
converted. Figure 2-1 shows the EVM hardware setup.

1. Verify that the ADS1x15 supply voltage is set to the 5-V setting at JP1.
2. Connect an input voltage to AIN0. The PAMBoard supply voltage can be used as a voltage source to the

ADS1x15. Use the 3.3-V source found at header J1 pin 1 and with a wire jumper connected to the J6 header
at pin 1 (A0).

ADS1115V2EVM-PDK

Figure 2-1. Hardware Setup

2.2 Step 2 - USB Connection and GUI Startup
The ADS1x15V2EVM-PDK GUI software can be run from a browser window. Additional software may need to
be installed if not installed previously. See Section 4.2 for additional details. When the GUI has started, plug the
ADS1x15V2EVM-PDK into an available USB port on the PC.
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2.3 Step 3 - Configuration and Data Collection
When the GUI has recognized the EVM, go to the chart window as identified in Figure 2-2.

1. Select the Chart icon on the left side of the GUI. Open the slide-out configuation from the right side of the
GUI and Show Capture Settings. Select the MUX input for AINP = AIN0 and AINN = GND from the Select
MUX Channels drop-down menu selection.

Figure 2-2. Capture Setting - MUX
2. Select FSR = ±4.096V from the Select FSR drop-down menu as shown in Figure 2-3. The selection is

needed to increase the full-scale range to measure the 3.3-V input.

Figure 2-3. Capture Setting - Full-Scale Range (FSR)
3. Close the slide-out configuration window by selecting Hide Capture Settings.
4. Choose Volts from the chart window for the Y-axis drop-down menu. See Figure 2-4.
5. Press the COLLECT DATA button to capture the data.

Quick Start www.ti.com
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6. The collected data appears in the chart window when the collection completes.

Figure 2-4. Data Capture
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3 ADS1x15EVM Overview
Various onboard components are used to interface the analog input, digital interface, and provide power to the
ADS1x15 device. The functional block diagram shows an ADS1x15V2EVM-PDK board overview.

3.1 ADS1x15EVM-to-PAMBoard Interface
The ADS1x15EVM supports the digital I2C and functional modes as detailed in the ADS1115 data sheet (or the
ADS1015 data sheet). The PAMBoard operates at a 3.3-V logic level and the digital I/O lines of the ADC are
level shifted to match the operating voltage of the ADS1x15.

Digital interface connections to the PAMBoard include power, I2C, and a GPIO connection used for triggering an
alert at the end of conversion if enabled. The digital connections are highlighted in the silkscreen, as shown in
Figure 3-1. Details regarding the connections are shown in Table 3-1.

Figure 3-1. ADS1x15EVM-to-PAMBoard Connections

Table 3-1. ADS1x1EVM Header Pinout and Description
Description Connector Connector Description Description Connector Connector Description

+3.3 V J1:1 J3:21 +5 V — J4:40 J2:20 GND

— J1:2 J3:22 GND — J4:39 J2:19 —

— J1:3 J3:23 — — J4:38 J2:18 —

— J1:4 J3:24 — — J4:37 J2:17 —

— J1:5 J3:25 — — J4:36 J2:16 —

— J1:6 J3:26 — — J4:35 J2:15 —

— J1:7 J3:27 — — J4:34 J2:14 —

— J1:8 J3:28 — — J4:33 J2:13 —

I2C SCL J1:9 J3:29 — — J4:32 J2:12 —

I2C SDA J1:10 J3:30 — ALERT/RDY J4:31 J2:11 —

ADS1x15EVM Overview www.ti.com
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3.2 Digital Interface
As noted in Section 3.1, the ADS1x15 interfaces with the PAMBoard and the PAMBoard communicates with
the computer over USB. The two devices on the EVM requiring communication are the ADS1x15 ADC (U1)
and the electrically erasable programmable read-only memory (EEPROM) (U3) using I2C (see Figure 6-5). The
EEPROM is preprogrammed with the information required to configure and initialize the ADS1x15V2EVM-PDK
GUI software platform. When the hardware is initialized through the software, the EEPROM is no longer used.

The PAMBoard and EEPROM (U3) use 3.3 V for the device interface logic levels. The ADS1x15 can operate at
either 3.3 V or 5 V as desired by jumper selection JP1. To allow the ADS1x15 to operate at 5-V logic levels, a
logic level translator (U2) is used.

3.3 Analog Input Connections
The ADS1x15 device is designed for easy interface to an external sensor that is differential or single-ended
using either a header (J6) or a screw terminal block (J5). Connector J6 provides an easy interface connection for
differential input pairs with each pair separated by analog ground. Table 3-2 lists the channel input connections
for J5 and Table 3-3 shows the input connections for J6. Both connectors are clearly labeled on the PCB
silkscreen for easy input connection identification.

Table 3-2. Terminal Block Input (J5)
J5 Terminal Block Inputs Description

J5:1 Analog input for AIN0 of the ADC

J5:2 Analog input for AIN1 of the ADC

J5:3 Analog input for AIN2 of the ADC

J5:4 Analog input for AIN3 of the ADC

J5:5 Analog ground

Table 3-3. Terminal Block Input (J6)
J6 Terminal Block Inputs Description

J6:1 Analog input for AIN0 of the ADC

J6:2 Analog input for AIN1 of the ADC

J6:3 and J6:4 Analog ground

J6:5 Analog input for AIN2 of the ADC

J6:6 Analog input for AIN3 of the ADC

Connector J5 is a screw terminal block for attaching an external sensor with bare wire connections. The terminal
block includes all four inputs and a connection point for analog ground. Figure 3-2 shows the input layout.

Figure 3-2. Analog Input Terminal Block (J5)

Connector J6 is a 100-mil spaced dual-row header. Jumper wire or clip leads can be used for connections. The
header includes all four inputs and two analog ground connections. Figure 3-3 shows the input layout.

Figure 3-3. Analog Input Header (J6)
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Each analog input includes a single-order, low-pass filter. The single-ended input filter cutoff frequency is
67.9 kHz. Up to four separate single-ended measurements are possible.

Instead of single-ended measurements, up to two differential input pair combinations are possible. The filter
design for the differential input pair filtering has a cutoff frequency of 3.4 kHz. The filter is populated on the
ADS1x15EVM for input pair combinations of AIN0 and AIN1 or AIN2 and AIN3. The input combination of AIN1
and AIN2 is possible by adding a 47-nF capacitor at C6 (see location in Figure 6-5).

CAUTION

The configuration options for the ADS1x15 allow for a potential full-scale range (FSR) greater than
the supply. This increased range is useful when an input voltage slightly exceeds the next lower
FSR. However, the input voltage should not exceed the range of the VDD supply selected at JP1.
The absolute input voltage is bounded by VDD + 0.3 V and GND – 0.3 V. Damage to the ADS1x15
may occur if the absolute input range is exceeded.

ADS1x15EVM Overview www.ti.com
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3.4 Power-Supply Options
The ADS1x15 supports a wide range of supply voltage from 2 V to 5.5 V. The ADS1x15EVM ADC voltage (VDD)
can operate from either 3.3 V or 5 V. Power is supplied from the USB 5-V source to the PAMBoard. However,
the USB power-supply voltage is not consistent from PC to PC. A DC/DC converter increases the USB output
to 5.5 V. A linear low dropout (LDO) regulator uses 5.5 V to establish a clean and stable 5 V and 3.3 V for the
ADS1x15V2EVM-PDK.

When the USB cable is plugged into the PC, two LEDs will light on the PAMBoard (Figure 3-4). The bottom LED
(D5) indicates that the 5-V output is active. The top LED (D1) indicates that the ADS1x15V2EVM-PDK is ready
to communicate with the GUI.

Figure 3-4. LED Indicators D1 and D5

Jumper JP1 selects the operating voltage for the ADS1x15 (Figure 3-5). When jumper JP1 is in the bottom
position the VDD to the ADS1x15 is set to 5 V and when in the top position the VDD supply is set to 3.3 V.

Figure 3-5. ADS1x15 Supply Setting Jumper (JP1)
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4 ADS1x15V2EVM-PDK Setup and Operation
The ADS1x15V2EVM-PDK requires a communication driver and GUI software for device configuration and data
collection. Driver installation is automatic. The USB enumerates as a composite device for communications
device class (CDC) and bulk. Commands are sent through CDC when data are collected by bulk transfers from
the PAMBoard. Additional information regarding any driver issues is located within this FAQ.

4.1 EVM Plug-In Instructions
Install jumper JP1 to the desired ADS1x15 operating voltage. Connect the USB micro cable to the PAMBoard
and attach the other end of the cable to an available USB port on the PC.

4.2 ADS1x15EVM GUI and TI Cloud Agent Installation
The following steps describe the ADS1x15 GUI software installation:

1. Verify that the micro USB to USB cable from the PAMBoard to a USB port on the computer is connected.
2. On the EVM landing page (ADS1115V2EVM-PDK or ADS1015V2EVM-PDK), the software is available

through a web-based GUI. Connecting to the GUI may require a login to a user account for access.
(Software GUI)

3. First-time users may be prompted to download and install the browser extension for Firefox™ or Chrome™

and the TI Cloud Agent application as shown in Figure 4-1. Installing the TI Cloud Agent is a one-time
download and installation.

4. Refresh the GUI. The GUI should connect to the hardware. A green signal displays, and the Hardware
Connected indication shows on the bottom (see Figure 5-3).

Figure 4-1. Browser Extension and TI Cloud Agent Installation
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5 ADS1x15V2EVM-PDK GUI
The Home page is the GUI start-up landing page. The Home page provides a high-level overview of the
ADS1x15 device. The horizontal menu bar (as shown in Figure 5-1) at the top of the GUI shows the menu
options:

• File
• Options
• Tools
• Help

Figure 5-1. Menu Bar Options

The upper corner of the GUI (as highlighted in the green box in Figure 5-2) shows vertical tabs available to
navigate through the various GUI displays. The vertical tabs starting at the top icon include:

• Home
• Chart
• Configuration

www.ti.com ADS1x15V2EVM-PDK GUI
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Figure 5-2. GUI Navigation Bar Options

The black ribbon at the bottom of the GUI shows connection status and log information. On GUI startup, the
software attempts to identify and verify that the EVM connected matches with the GUI. An EEPROM on the
ADS1x15V2EVM-PDK contains information specific to the EVM connected. A properly connected and identified
EVM displays as Device Connected with a green indicator and at the bottom as Hardware Connected in the
status ribbon. Figure 5-3 shows both the black ribbon information and the device connected radial button in
green boxes.

Figure 5-3. ADS1x15V2EVM-PDK Connected GUI (ADS1115 shown)
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5.1 Menu Bar
The Menu bar across the top of the GUI displays the device name used on the EVM along with a number of
drop-down menu options.

5.1.1 File Menu

As shown in Figure 5-4, the File drop-down menu displays all available options. These options include:

• Program Device
• Analysis Data

– Save data
– Load data

• Register Data
– Save register settings
– Load register settings

Figure 5-4. File Menu

The Program Device option is only necessary if an important firmware change is required. If reprogramming
the PAMBoard firmware becomes necessary, an additional pop-up box displays with information on the
programming procedure.

By using the Save data option, the Analysis Data (as illustrated in Figure 5-5) is saved to a comma separated
values (CSV) formatted file for further analysis using external programs. The data can also be loaded back into
the GUI for further review or analysis by selecting Load data.
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Figure 5-5. Analysis Data Options

Register Data (as shown in Figure 5-6) can be saved for a particular configuration by selecting Save register
settings. A previously saved configuration can be loaded back into the GUI again when testing various device
configurations by using Load register settings.

Figure 5-6. Register Data Options

ADS1x15V2EVM-PDK GUI www.ti.com
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5.1.2 Options Menu

The Options drop-down (shown in Figure 5-7) provides information regarding the serial COM port the GUI is
using. By selecting Serial Port, the serial COM port information displays the current COM port settings in a
pop-up dialog (Figure 5-8) with options to change the COM port or reconfigure the settings as necessary.

Figure 5-7. Options Menu

Figure 5-8. Serial Port Configuration Settings
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5.1.3 Tools Menu

The Tools drop-down menu (shown in Figure 5-9) displays the Log pane option. The Log pane (as shown in
Figure 5-10) displays the activity information log at the bottom of the GUI. The Log pane displays the same
information as when clicking the book icon in the status ribbon.

Figure 5-9. Tools Menu

Figure 5-10. Logs Display
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5.1.4 Help Menu

The Help drop-down menu (shown in Figure 5-11) displays the following:

• E2E Support Forum provides a link to the E2E forum for asking questions or searching the E2E forum.
• View README.md displays pertinent startup information not necessarily included in this guide.
• About displays specific information regarding the GUI and EVM hardware.

Figure 5-11. Help Menu

As shown in Figure 5-12, information specific to the GUI build and the connected hardware is found by selecting
About from the drop-down Help menu.

Figure 5-12. Help Information (About)
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5.2 Navigation Bar

5.2.1 Home

The Home page includes links to a variety of information. These links include this user’s guide, the EVM
schematic, as well as support resources. Next to the connection status indicator is an information icon. Clicking
the icon displays specific information regarding the ADS1x15V2EVM-PDK, as shown in Figure 5-13.

Figure 5-13. Connected Hardware Information

At the bottom of the GUI is a black ribbon with status information. The status shows if the hardware successfully
connects to the PC and the COM port used. The status ribbon displays regardless of the navigation page
selected.

5.2.2 Chart

The Chart icon selects the available charting options for displaying conversion data. The data options include a
Time Domain, Histogram, and FFT displays.

The Chart tab allows configuration of the Data Capture for the ADS1x15. At the upper right of the capture
window (as illustrated in Figure 5-14) is the setting for the number of Samples to collect. To capture data, press
the Collect Data button displayed at the upper corner of the window.
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Figure 5-14. Data Capture Window

Conversion data collects when the Collect Data button is pressed. The button will then change to Stop Collect
and, by pressing this button, the collection of conversion data will stop. If this button is not pressed, data are
collected for the number of Samples given. The number of Samples can be changed prior to pressing Collect
Data by selecting the Samples and directly entering the desired number of samples or by clicking on the up and
down arrows. The number of samples cannot be changed while data are being collected.

When the Collect Data operation is complete, the data will display with the calculated channel statistics and a
plot of the data in the chart window. Various icons for viewing the data include zoom, pan, and home. The home
icon restores the graph to show all data collected. The viewing icons are underneath the statistics information on
the right side of the GUI.

Also on the right side of the chart window is a slide-out menu where configuration settings are displayed and
changes can be made for data collection.

5.2.2.1 Channel Statistics

When data collection completes, statistical information displays along with the charted data. The statistical
display for Time Domain and Histogram are the same, but the FFT statistics differ. Because the ADS1x15 is
primarily a DC measurement device, the FFT plot and information may have little meaning.

5.2.2.1.1 Time Domain and Histogram Statistics

As depicted in Figure 5-15, the Time Domain and Histogram plots share the same statistical information:

• Input Channels selected
• Min code within the data set
• Max code within the data set
• Mean code value within the data set
• Std Dev representing the standard deviation within the data set
• Pk-to-Pk representing the total noise peak-to-peak within the data set
• Eff. Res representing the effective resolution as number of bits with the value in parenthesis showing the

noise-free number of bits
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Figure 5-15. Capture Statistics

5.2.2.1.2 FFT Statistics

The FFT plot (see Figure 5-16) displays the following statistics:

• Input Channels selected
• Fundamental frequency
• Fundamental power
• Noise floor
• SNR or signal-to-noise ratio
• SFDR or spurious free dynamic range
• THD or total harmonic distortion
• SINAD or signal-to-noise and distortion
• ENOB or effective number of bits
• Harmonics
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Figure 5-16. FFT Statistics

5.2.2.2 Time Domain Plot

The Time Domain plot (shown in Figure 5-17) displays the sample count number in the X-axis. The Y-axis is
displayed as either codes or volts with the selection in a drop-down menu. The Y-axis drop-down menu displays
next to the charting icons near the right side of the GUI below the statistics.

Figure 5-17. Time Domain Plot

5.2.2.3 Histogram Plot

The Histogram plot (Figure 5-18) shows the number of occurrences a code or group of codes appear. User
selection includes a choice of:

• # of Bins selecting the number of bins to include in the plot
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• Bin Size selecting the number of unique codes to include in each bin

Figure 5-18. Histogram Plot

The # Bins and Bin Size are selectable options and display next to the charting icons near the right side of the
GUI below the statistics.

5.2.2.4 FFT Plot

The FFT plot (as shown in Figure 5-19) is rather meaningless for dc input voltages. However, a low-frequency
AC signal can be analyzed and the FFT plot displayed.

Figure 5-19. FFT Plot
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5.2.2.5 Capture Configuration Settings

A slide-out menu is viewable on the right side of the Chart window. By clicking the slide-out for Show Capture
Settings, various configurations display and are selectable (as shown in Figure 5-20 in the green box). The
drop-down menu Capture Settings are:

• Select data rate for the data output conversion rate
• Select MUX channels by choosing the desired input channels to be converted
• Select FSR for choosing the voltage input measurement range

Figure 5-20. Capture Settings

5.2.3 Configuration

The Register Map window (Figure 5-21) contains information about the configuration and the last conversion
data from the ADS1x15. The Conversion register contains the value of the last 16-bit conversion result read from
the ADS1115. For the ADS1015, the conversion data are 12-bit left-justified in the 16-bit register.

Because the ADS1x15 is a programmable device, the Config, LoThresh and HiThresh registers are
programmable and 16 bits in length.

A number of control buttons and drop-down menus exist to configure the Register Map read and write operations
when data are written and read from the ADS1x15.

Question mark icons (?) appear throughout the Register Map window. Clicking these icons opens details
pertaining to the items in the locations where they appear.
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Figure 5-21. Register Map

The GUI displays four registers (as shown in Figure 5-22) but only three are configurable in the ADS1x15
device. For the firmware to remain in synchronization with the GUI, all communication is first directed to a pointer
register internal to the device and either points to the Conversion register or one of the three configuration
registers.

The ADS1x15 primary configuration is accomplished with the Config register. The Register Map data are specific
to the GUI and firmware combination for the ADS1x15EVM.

Configuration of the ADS1x15 device is accomplished using the drop-down menu and click options shown in the
Field View on the right side of the GUI window. The various bits can also be double-clicked to toggle the bit
settings. As the bit settings change, the Field View options also change to correspond to the selection.

Figure 5-22. ADS1x15 Configuration

ADS1x15V2EVM-PDK GUI www.ti.com

26 ADS1x15V2EVM-PDK User's Guide SBAU362 – MARCH 2021
Submit Document Feedback

Copyright © 2021 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/feedbackform/techdocfeedback?litnum=SBAU362&partnum=ADS1X15V2EVM


The ADS1x15 device also contains an internal comparator. The threshold limits for the comparator are set using
the HiThresh and LoThresh registers.

5.2.3.1 Register Read and Write Options

At the top and right side of the Register Map window (as shown in Figure 5-23) are controls for reading and
writing the registers. The startup default control values are to Immediately Write the Config register when options
change. The Auto Read register function is turned off.

Figure 5-23. Register Read and Write Controls

5.2.3.1.1 Read Register Options

The default GUI configuration is to have the Auto Read functionality turned off and instead manually read the
registers using the READ REGISTER and READ ALL REGISTERS buttons. The READ REGISTER button reads
only the selected register. The READ ALL REGISTERS button reads all registers available for the ADS1x15
device. The advantage of manually reading the register contents is a reduction in USB communication between
the ADS1x15EVM and the GUI.

The registers can be read automatically from the ADS1x15 at a variety of intervals from once a second to as fast
as possible. The Auto Read drop-down menu selection (Figure 5-24) shows these intervals, which can each be
selected based on the application needs. The READ REGISTER and READ ALL REGISTER button options are
only enabled when the Auto Read selection is turned off.
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Figure 5-24. Auto Read Options

5.2.3.1.2 Write Register Options

The GUI default option for register writes is Immediate Write. When Immediate Write is selected (as indicated
by the green box in Figure 5-25), any register configuration changes are immediately written from the GUI to the
ADS1x15 device. Using the Immediate Write option ensures that what is being displayed is what is configured in
the ADS1x15.

If the write register drop-down menu selection is for a Deferred Write, then the write register buttons WRITE
REGISTER and WRITE ALL REGISTERS become enabled. Similar to the functionality of the read register
buttons, the WRITE REGISTER button will write the configuration for the currently selected register. When
selecting the WRITE ALL REGISTERS button all configurable registers will be written.

Figure 5-25. Register Write Options
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5.3 Connection Status
The connection status (as indicated in the green box in Figure 5-26) shows at the bottom of the GUI in the
black status ribbon. At the left side of the status ribbon is a book icon that when selected, allows for the log
information to be displayed. Next to the book icon is a connection icon. This icon shows the visual representation
of the connection status also displayed as text. The icon shows as a connected link when the EVM and GUI
are connected, and appears as a broken link when not connected. Clicking on the icon will attempt to connect if
disconnected and will disconnect if the EVM is currently connected. The last icon shows as an arrow and clicking
the icon toggles the display of connection details.

Figure 5-26. Status Information
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6 Bill of Materials, Printed Circuit Board Layout, and Schematics
This section contains the ADS1x15EVM bill of materials (BOM), printed-circuit board (PCB) layout, and board
schematic.

6.1 Bill of Materials
Table 6-1 lists the bill of materials (BOM) for the ADS1x15EVM.

Table 6-1. Bill of Materials
Designator QTY Description Manufacturer Part Number Manufacturer

C1, C2, C3, C4 4 CAP, CERM, 4700 pF, 50 V, +/- 5%, X7R, 0603 C0603C472J5RACTU Kemet

C5, C7 2 CAP, CERM, 0.047 uF, 50 V, +/- 10%, X7R, 0603 C1608X7R1H473K080AA TDK

C8, C10, C11,
C12

4 CAP, CERM, 0.1 uF, 10 V, +/- 10%, X7R, 0402 CL05B104KP5NNNC Samsung Electro-
Mechanics

C9 1 CAP, CERM, 1 uF, 10 V, +/- 10%, X7S, 0402 C1005X7S1A105K050BC TDK

C13, C14 2 CAP, CERM, 10 µF, 25 V,+/- 5%, X7R, AEC-Q200
Grade 1, 1206

C1206C106J3RACAUTO Kemet

J1/J3, J2/J4 2 Receptacle, 2.54mm, 10x2, Tin, TH SSQ-110-03-T-D Samtec

J5 1 Terminal Block, 3.5mm Pitch, 5x1, TH ED555/5DS On-Shore
Technology

J6 1 Header, 100mil, 3x2, Gold, TH TSW-103-07-G-D Samtec

JP1 1 0.025" SQ Post Header, Through-hole, Vertical, -55
to 125 degC, 2.54 mm Pitch, 3-Pin, Male, RoHS

TSW-103-07-G-S Samtec

R1, R2, R3, R4 4 RES, 499, 1%, 0.1 W, 0603 RC0603FR-07499RL Yageo

R5, R7, R10,
R13

4 RES, 10 k, 5%, 0.1 W, AEC-Q200 Grade 0, 0402 ERJ-2GEJ103X Panasonic

R8, R9, R11,
R12

4 RES, 4.70 k, 1%, 0.1 W, 0402 ERJ-2RKF4701X Panasonic

R14 1 RES, 0, 1%, 0.1 W, AEC-Q200 Grade 0, 0603 RMCF0603ZT0R00 Stackpole
Electronics Inc

SH-J1 1 Shunt, 100mil, Gold plated, Black SNT-100-BK-G Samtec

TP1, TP2, TP3 3 Test Point, Multipurpose, Black, TH 5011 Keystone

U1 1 16-Bit (or 12-bit), 860SPS (or 3300SPS), 4-Ch
Delta-Sigma ADC w/ PGA, Oscillator, Voltage
Reference, Comparator & I2C, RUG0010A
(X2QFN-10)

ADS1115IRUGR (or
ADS1015IRUGR)

Texas Instruments

U2 1 TCA9406 Dual Bidirectional 1-MHz I2C-BUS and
SMBus Voltage Level-Translator, 1.65 to 3.6 V, -40
to 85 degC, 8-pin SM8 (DCT), Green (RoHS & no
Sb/Br)

TCA9406DCTR Texas Instruments

U3 1 I2C BUS EEPROM (2-Wire), TSSOP-B8 BR24G32FVT-3AGE2 Rohm

C6 0 CAP, CERM, 0.047 uF, 50 V, +/- 10%, X7R, 0603 C1608X7R1H473K080AA TDK

R6 0 RES, 10 k, 5%, 0.1 W, AEC-Q200 Grade 0, 0402 ERJ-2GEJ103X Panasonic

TP4, TP5 0 Test Point, Miniature, SMT 5019 Keystone

TP6 0 Test Point, Multipurpose, Red, TH 5010 Keystone
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6.2 Printed Circuit Board Layout
Figure 6-1 to Figure 6-4 depict the ADS1x15EVM PCB layout.

Figure 6-1. Top Silkscreen
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Figure 6-2. Top Layer
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Figure 6-3. Bottom Layer
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Figure 6-4. Bottom Silkscreen
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6.3 Schematics
Figure 6-5 shows the ADS1x15EVM schematic.

Figure 6-5. ADS1x15EVM Schematic (ADS1115EVM Only)
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